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Overview
Congratulations on successfully completing your Comprehensives! This handbook will guide you through the final steps of your degree program after passing your comprehensive exam. You will find:
· Remaining course requirements
· Procedures for forming your dissertation committee and submitting a proposal
· Details regarding your defense and public lecture
· Procedures for submitting final dissertation to ProQuest and UDSpace
· Details regarding graduation
· General checklist of tasks to complete
· Formatting requirements and necessary forms
· Sample Dissertation Proposal

Immediately following the descriptive information here, you will find a timeline and checklist that identifies the basic chronology according to which you should, and in some cases, must, complete tasks. As soon as possible, please read this entire Handbook, as some details will differ according to when you fulfill certain course requirements.
The Ph.D. dissertation is written under the direction of a dissertation committee and in close collaboration with the dissertation director, also referred to as your “first reader” and/or “dissertation advisor.” Toward the end of your coursework, you should have visited with your concentration director, the IPS director, and various members of the faculty with a view toward identifying a viable dissertation topic and qualified prospective director.
The Braniff Graduate School does not have a dissertation office to monitor the general formatting requirements for the dissertation. Therefore, it is the sole responsibility of the candidate to adhere to the standards outlined in this document. Although the Braniff Graduate Office does set minimum requirements for the dissertation, the office will not check the mechanical elements of the paper (such as: grammar, formatting, punctuation, margins, page numbers, etc.). 
Finally, within two weeks after you successfully defended your dissertation, you are required to upload a final copy of your dissertation to UDSpace and ProQuest as a permanent record of your academic research. You will have the option of printing copies of your dissertation through ProQuest, but you are not required to provide a physical copy of your dissertation to the university. 
If you have any questions, please contact the Braniff Graduate Office.
	Braniff Graduate School 124 (first floor Braniff)
	1845 East Northgate Drive
	Irving, TX 75062
Phone: (972) 721-5106
	Email: braniff@udallas.edu
	
graduation

Remaining Course Requirements

Before taking your comprehensive examinations, you filled out and submitted to the Graduate Office a Degree Audit Form, showing that you had completed all of the core and concentration courses required for your degree plan. Your transcript also indicated, at that time, that you had passed your qualifying examination and had fulfilled one or both of your language requirements.  

At this point, if you have fulfilled only one language requirement, you should complete the requirement for your second language before submitting anything official regarding your dissertation.

After finishing academic course work, you should sign up for 8V99 Doctoral Readings. This course qualifies you as a full-time student, entitling you to the use of the library and other University services as well as deferral of loans. Students must take courses 2 out of 3 semesters in an academic year to remain active. 

Prior to defending your dissertation, you must take 9697 Dissertation Research I and 9698 Dissertation Research II. These courses are 6 credit hours each and are covered in full by the Braniff tuition scholarship. They will be translated into your dissertation grade on the day of your defense. 

Students must complete all coursework, all language requirements, the Comprehensive Examination, and submit a Dissertation Proposal Approval Form to the Braniff Graduate Office before enrolling in Dissertation Research I. 

Applicants are admitted to candidacy after successfully completing all course requirements, satisfying both language requirements, and passing the Comprehensive Examination. Having completed these requirements, you may use the “Ph.D. (cand.)” after your name. 
You have ten years from the time that you began your coursework to complete your degree.

Forming your Dissertation Committee and Submitting a Dissertation Proposal
A dissertation is written under the direction of a faculty member and is not a free-lance operation for which one later seeks endorsement. This means the topic ought to be one of interest to your potential director and one in which they have special competence. Therefore, in the earliest stages of considering a dissertation proposal, you should formulate the thesis and its development in consultation with a professor you hope will be your dissertation director. This collaboration is more likely achieved if you have prepared the way in previous course work, term papers, and serious discussion on the topic with members of the Institute faculty. 

Once you have identified your dissertation director, you should consult about the other two readers, perhaps in conjunction with the dean and IPS director. One of these latter two may be a scholar from another academic institution. Your dissertation proposal should be written under the direction of your dissertation director.

After your full dissertation committee has approved your proposal, submit a copy of the proposal and the Dissertation Proposal Approval Form to your concentration director for approval and a signature. Then, return the form and a copy of the approved proposal to the Graduate Office for the IPS director’s official approval.  

The proposal should state the thesis to be developed, outline the basic argument of the dissertation, and indicate the general direction and/or key areas of research.  It should include a complete bibliography of primary source material and a substantial selection of relevant secondary references. In length, the narrative of the proposal should be no shorter than four or five (double-spaced, typed) pages. A brief sample proposal can be found below. 


Formatting Overview and Requirements for Final Dissertation
The following details govern the cosmetic presentation of your dissertation. Again, the Graduate Office does not have a dissertation secretary, so you alone are responsible for seeing that your dissertation meets the standards for proper format. Also, you are responsible for checking that your dissertation displays properly in .pdf format. 
The final copies of your dissertation should adhere to the most recent edition of either The Chicago Manual of Style or the MLA Handbook for Writers of Research Papers.
Recommended Document Order and Page Number Guidelines
	Section
	Page Numbering

	Abstract
	No Page Number

	Title Page
	No Page Number

	Copyright Page
	No Page Number

	Epigraph (optional)
	No Page Number

	Table of Contents
	No Page Number

	List of Illustrations (if applicable)
	No Page Number

	List of Tables (if applicable)
	No Page Number

	Preface or Acknowledgements (optional)
	Page number starting from Abstract (i)

	Introduction (optional)
	Page numbering continued from Preface/Acknowledgements (ii)

	Body of Dissertation
	Start on page (1) 

	Appendix (if applicable)
	Continue numbering from Body (2)

	Notes
	Continue numbering from Appendix (3)

	Glossary (if applicable)
	Continue numbering from Notes (4)

	Bibliography
	Continue numbering from Glossary (5)

	Index (if applicable)
	Continue numbering from Bibliography (6)



Further Details
Pagination
· As displayed above, no page number should appear on the abstract, title page, copyright page, dedication, epigraph, table of contents, list of illustrations, or list of tables, although they will be counted toward your final page count. 
· Beginning with the first page of the Preface/Acknowledgements, pages should be numbered in lower case Roman numerals, although the numerals should begin with the page number that follows the total pages thus far in the dissertation, from the abstract forward. 
· Use Arabic numerals to paginate the text, appendix, endnotes, glossary, bibliography, and index. 
Margins
· Left: 1”; Right: 1”; Top and Bottom: 1”
· Do not justify the right margin. 
Font
· Embedded fonts required (guide). Post Script Type 1 fonts required.
· Any legible font equivalent in scale to 12pt. Times New Roman accepted. Script, italic, or ornamental fonts are not acceptable. However, italicized font may be used for non-English words and quotations.
· Use the same font size throughout the entire text. 
· Font color must be black, without highlighting.
· Font requirements apply to all text including captions, footnotes, citations, etc.
Line Spacing
· Double Space: Abstract, Dedication, Acknowledgements, Table of Contents, and Body of the manuscript, except for quotations as paragraphs, captions, items in tables, lists, graphs, charts. 
· Single Space: footnotes/endnotes, bibliographic entries, lists in appendices.
Additional Information
Use the following information for the heading, typed in four, single-spaced lines in the upper left-and corner of the first page:
	TITLE (all in capital letters)
	Student’s Name
	University of Dallas, Year of Graduation
	Director’s Name

The abstract must not exceed 350 words. The abstract body should include a synopsis of the problem you researched, the procedures or method of study you used, and the conclusions reached in the dissertation. The text should be double-spaced.




Conducting the Oral Defense and Public Lecture
Your dissertation director should be in consultation with the IPS director as you approach the completion of your dissertation regarding the timing of your defense. Work with your dissertation director and committee members to set up the date and time for your oral defense. The defense committee includes the dissertation director as chair, the other readers, and at least one faculty representative from each concentration of the IPS, who are appointed by the IPS director after consultation with your dissertation director. 

As your defense approaches, print an unofficial copy of your transcript and compare it with the IPS degree audit to check to see that all graduation requirements are listed. They are as follows.

	☐ 21-hour Core sequence (including an approved Bible course)
	☐ 45 hours Concentration credits (9 of which may be in another area)
	☐ Course Work GPA is ≥ 3.0
	☐ Qualifying Examination
	☐ Comprehensive Examination
	☐ Ancient Language
	☐ Modern Language
	☐ Dissertation Research I
	☐ Dissertation Research II


Five days before your oral defense, you should provide a final electronic copy of your dissertation to all the members of your dissertation defense committee. An unsuccessful defense means that the dissertation will not be accepted and the doctoral degree not be awarded.  A second and final defense will be permitted by the examiners after you have made the required corrections or revisions.

After you have successfully completed your oral defense, you must present a public lecture of approximately thirty minutes, based upon your dissertation. The lecture usually follows your oral defense on the same day, and a reception, given by the Graduate Office, follows the lecture.  The IPS director or your dissertation director will normally preside at the lecture.


Post-Defense and Pre-Graduation Requirements
After successfully defending your dissertation, you should complete the Survey of Earned Doctorates (SED), which can be completed online at https://sed-ncses.org/. The SED is an annual census of all individuals receiving a research doctorate from an accredited U.S. institution in a given academic year and is used in shaping policy and program decisions. 
[bookmark: _Hlk208505418]When you have finalized all changes to your dissertation, you must upload your completed dissertation to UDSpace and ProQuest at least a week before the graduation date. To submit your dissertation to UDSpace, open the EDT submission form found here and complete the form. After you have completed the form, you will download it and submit it, along with a PDF copy of your completed thesis to archives@udallas.edu. You must also include a PDF copy of the dissertation defense form signed by the defense committee (without a grade) from the Braniff Office after your defense confirming acceptance of your work. To submit your dissertation to ProQuest, visit ProQuest ETD Administrator - Home and follow the directions provided on the site. An additional guide can be found below. Please contact archives@udallas.edu with any questions regarding either submission process. 

Graduation and Convocation
You must apply for graduation within the first two weeks of the semester in which you intend to graduate. Complete the Degree Application Form and return it to the Graduate Office. 
The University loans graduation regalia to all doctoral students for graduation. At least two weeks before the graduation day, make an appointment with Rosemary Crocker (rcrocker1@udallas.edu) in the Office of the President.  You may take the robe, cap, and hood home at that time.  Return the regalia, on the hanger, to Rosemary Crocker on the Monday after the ceremony.  (If you wish to purchase your regalia for the May ceremony, contact the Registrar  by the December before you graduate.  You may also purchase your regalia after you graduate; see the Registrar for further details.)

On Graduation Day, arrive at the venue at least 45 minutes before the ceremony is scheduled to begin, bringing your robe, hood, and cap with you.  Once there, you should put on your cap and robe, but you will carry your hood over your arm to be officially “hooded” in the ceremony.  

Doctoral candidates lead the student procession into Graduation, lined up alphabetically according to disciplines: first literature, then philosophy, then politics.  

A General Checklist of Tasks
☐ Fulfill second language requirement if not already completed. 
☐ Determine your dissertation director and two other readers.
☐ Enroll in Doctoral Readings until your dissertation proposal has been approved.
☐ Write your dissertation proposal and submit it to your dissertation director for approval.
☐ Complete the Dissertation Approval Form (below) and submit it, along with a copy of your proposal, to the Braniff Graduate Office.
☐ Register for Dissertation Research I.
☐ Register for Dissertation Research II when nearing the final semester of your dissertation. Enroll in Doctoral Readings if you are not ready for Dissertation Research II or if you have already taken it. 
☐ Apply for graduation within the first two weeks of the semester in which you plan to graduate.  (You may officially graduate in May, August, or December, but the only formal ceremony for Braniff is in May.  Those who graduate in August or December are eligible to walk in the upcoming May ceremony.)
☐ If you wish to purchase graduation regalia for a May ceremony, contact the Registrar  by December of that academic year.
☐ Once the completion of your dissertation is in sight, work with your director and committee members to set up the final date of your dissertation defense and lecture. We recommend that you give them 3 different options that work best for everybody.  Let the Braniff Office know as soon as you have the final date so the other members of your defense panel may be appointed.
☐ Five days before your defense, send an electronic copy of your dissertation to your entire defense (not just your dissertation) committee.  
☐ Successfully defend your dissertation and give your public lecture.
☐ Submit your dissertation to UDSpace.
☐ Submit your dissertation to ProQuest.
☐ If you intend to walk in May, at least two weeks before Graduation Day, schedule a meeting with the Rosemary Crocker at rcrocker1@udallas.edu  to try on the regalia that you will borrow for the ceremony.  
☐ Before Graduation Day, complete online the Survey of Earned Doctorates.
☐ Graduate!
☐ Return to Rosemary Crocker any borrowed graduation regalia the Monday after the ceremony.
☐ Notify the alumni office of future plans.  




[bookmark: bookmark=id.gjdgxs]

Braniff Graduate School of Liberal Arts
Dissertation Proposal Approval Form
Date: _____________
Name of Candidate: _____________________________________________  
Dissertation Title:    _____________________________________________
            _____________________________________________

Dissertation Readers: 1. ______________________________________   
    2. ______________________________________  
 			    3. ______________________________________ 

Approved by: 

_________________________________________________
Program Director

_________________________________________________________
IPS Director

_________________________________________________________
Graduate Dean

Please return this form to the Graduate Office.





[bookmark: bookmark=id.30j0zll]THE BRANIFF GRADUATE SCHOOL
OF THE
UNIVERSITY OF DALLAS

THE TITLE OF YOUR DISSERTATION
by
YOUR FULL NAME

B.A., THE NAME OF UNIVERSITY, DATE

M.A., THE NAME OF UNIVERSITY, DATE



A dissertation submitted to the Graduate Faculty of the University of Dallas in partial fulfillment of
requirements for the degree of Doctor of Philosophy in (Discipline) 
in the Institute of Philosophic Studies.



DATE

Reading Committee:

[Chair Name], Chair
[Member Name]
[Member Name]








[bookmark: bookmark=id.1fob9te](Sample Dissertation Proposal)

A.Title

The Structure and Argument of Plato's Republic

B.Thesis

	The structure of Plato's Republic affords a basic clue for understanding what is at stake in the overall argument.  

C. 	Elaboration

	The fundamental structure of Plato's Republic is an ascent from Book 1 to the appearance of the notion of the good in Book 6 followed by a descent through declining forms of order to the final mythical descent into Hades that concludes Book 10.  The structural metaphor is implicit in the very first line of book 1, "I went down to the Peirius yesterday...."  It is followed by Socrates's attempt to "ascend to the city" with Glaucon, when he is arrested by a group of interlocutors whom he must persuade in order that he might be allowed to continue the ascent to the city with Glaucon.  

	A reflective descent into Hades by Cephalus initiates the discussion of justice.  The character-types decline away from Cephalus and descend through Polemarchus to Thrasymachus as the argument ascends in complexity and depth.  Glaucon and Adeimantus carry Thrasymachus's argument back to its foundation in common opinion.

	Socrates's response develops an image of the soul in the construction of three successive strata to a polis constituted in speech (en logois):  the healthy city is concerned with biological necessities.  The luxurious city develops the division of labor at the first level, falling out of natural, biological measure into a measureless desire for luxuries, an inverted image of the desire for Beauty.  The third level purges this desire by measured music and gymnastics, under the aegis of setting up a parallelism between the soul and the city, whereby the soul's desire is limited to the good of the city.  

	This furnishes what appears to be "the height of the argument" at the end of Book 4.  At this point the basic structural problem arises, which Socrates anticipates by indicating that the truth will not be accessible by the method that he employs there.

	At that point he deals with the tripartite division of the soul and the linking of the cardinal virtues with that division in order to discover the nature of justice.  He is about to go on through what are now Books 8 and 9 which will treat the descending forms of order in the city and the soul, following out the ascent-descent theme.  But he is again prevented by his interlocutors who are interested in the community of wives.  The impetus provided by this interest leads to the apparent digression of Books 5, 6 and 7 that in fact constitutes the height of the work.  Here we have the ascent to the philosopher king whose interest transcends the polis by reason of his ascent out of the Cave of common opinion, up the Line of Knowledge to the Good, which is presented initially as Beauty Itself.

	The argument then resumes the projected descending forms of order in books 8 and 9 and draws the conclusion as to the superiority of the philosophic type to the tyrannical type represented by Thrasymachus.  Book 10 concludes with the poetizing of Plato in the Myth of Er that deals with the judgment of the dead in the afterlife according to their justice or injustice in this life.

	The overall argument, understood in terms of the central structural feature of ascent and descent, rendered problematic by the apparent digression of books 5 - 7, poses the problem of an essential tension between the philosophic dimension of the soul and the desire of the polis.  The polis defines itself in opposition to other poleis and demands the allegiance of its members; the soul by nature is related to the whole of being (and thus to all human beings) by desiring the Source.  Human beings exist as a tension between the immanent demands, not only of biology, but also of political life in the broad sense, and the essential transcendental reference of each person.

	The dissertation will examine these contentions in detail.
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[bookmark: _GoBack]Uploading a Thesis or Dissertation to ProQuest 
This document will guide students through the steps for submitting their completed thesis or dissertation to ProQuest. Prior to beginning the online process, a few preparations should be made.
1. Save the thesis/dissertation in PDF format. Double check the document to ensure that all parts are displaying properly in PDF form.
	2. Prepare a written abstract saved as a separate PDF.
	3. Gather any supplemental files (audio, video, spreadsheets, etc.).

[image: ]

Do not proceed with submitting your dissertation until you have in hand the signed defense form. This form can be acquired from the Braniff Office on the next business day after you successfully defended your dissertation.

[bookmark: _Hlk208509450]Students will then visit ProQuest ETD Administrator - Home to begin the process of uploading their thesis or dissertation. On the home page click sign up and get started, which is an orange box located near the bottom of the page. Then, select University of Dallas from the list of available schools. This will take you to create a new student account. After creating a new student account (Please NOTE of your registered account name as you will use the same account in tracking and organizing your dissertation and future research/articles), ProQuest will walk students through the process of submitting all of the necessary information. Items to be submitted are as follows:
	1. PDF of thesis or dissertation
	2. Abstract
	3. Supplemental Files
	4. Names of committee members
	5. Selection of subjects from a subject category list that is provided on the website

After uploading all of the relevant information, ProQuest will take students through publishing options and copyright agreements. It is important to note that there is no cost to students for submitting their work to ProQuest. ProQuest does provide optional services for bound print copies and filing additional copyright paperwork, among other services, and each of these optional services have an associated fee if selected. Additionally, the copyright is non-exclusive. 
When students reach the university agreement page, they will click to accept the agreement at the bottom of the page. The form on this page is not fillable. Students can print this page off, fill it out, and turn it in to the library or scan and email it to archives@udallas.edu. Students also will have access to this page through the instructions for uploading their thesis/dissertation to UDSpace and may complete it during this process instead. The University Agreement form does not need to be submitted twice. 
After students have finalized their submission and submitted their work to ProQuest, it takes an average of 4-6 weeks after submission before the work will be discoverable on ProQuest. 

[bookmark: bookmark=id.tyjcwt]
How to Embed Fonts

USING MICROSOFT WORD ON A PC

To embed your fonts in Microsoft Word 2010
1.    Create your manuscript using a TrueType font. Recommended fonts include Times-New Roman and Helvetica.
2.    In the File pull-down menu click on Options.
3.    Choose Save on the left sidebar.
4.    Check the box next to Embed fonts in the file.
5.    Click the OK button.
6.    Save the document.

To embed your fonts in Microsoft Word 2007
1.    Create your manuscript using a TrueType font. Recommended fonts include Times-Roman and Helvetica.
2.    Click the circular Office button in the upper left corner of Microsoft Word.
3.    A new window will display. In the bottom right corner is a button, Word options. Click the Word Options button.
4.    Choose Save from the left sidebar.
5.    Check the box next to Embed fonts in the file.
6.    Click the OK button.
7.    Save the document.
To embed your fonts in earlier versions of Microsoft Word
1.    Create your manuscript using a TrueType font. Recommended fonts include Times-Roman and Helvetica.
2.    On the Tools menu, choose Options
3.    Click the Save tab.
4.    Select the Embed TrueType fonts check box.
5.    Save the document.



USING MICROSOFT WORD ON A MAC

Microsoft Word 2008 on a Mac OS X computer will automatically embed your fonts while converting your document to a PDF file. Please note that previous versions on Microsoft Word on a Mac are not able to embed fonts.
Another option you might consider is using OpenOffice (which embeds fonts automatically while converting to PDF) or using a PC to embed fonts in your manuscript.







[bookmark: _heading=h.3dy6vkm]USING ADOBE ACROBAT PROFESSIONAL

Alternatively, if you have Adobe Acrobat Professional available to you, you can follow the excellent instructions provided by the Graduate Thesis Office at Iowa State University:
1. Open your document in Microsoft Word.
2. Click on the Adobe PDF tab at top. Select Change Conversion Settings.
3. Click on Advanced Settings.
4. Click on the Fonts folder on the left side of the new window. In the lower box on the right, delete any fonts that appear in the Never Embed box. Then click OK.
If prompted to save these new settings, save them as "Embed all fonts."
5. Now the Change Conversion Settings window should show "embed all fonts" in the Conversion Settings drop down list and it should be selected. Click OK again.
6. Click on the Adobe PDF link at the top again. This time select Convert to Adobe PDF. Depending on the size of your document and the speed of your computer, this process can take 1-15 minutes.
7. After your document is converted, select the File menu at the top of the page. Then select Document Properties.
8. Click on the Fonts tab. Carefully check all of your fonts. They should all show "(Embedded Subset)" after the font name.
9. If you see "(Embedded Subset)" after all fonts, you have succeeded.
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